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FOREWORD

The CADD/GIS Technology Center for Facilities, Infrastructure, & Environment (i.e., the Center)
is responsible for the design, development and maintenance of the Spatial Data Standard for
Facilities, Infrastructure, and Environment (SDSFIE), and the Facility Management Standard for
Fecilities, Infrastructure, and Environment (FMSFIE). These Standards are being developed so
GIS and CADD users within the CADD/GIS community can easily transfer and communicate
data and information. The FMSFIE is being designed to integrate with the SDSFIE and the A/E/C
CADD Standards and will consider business processes and more detailed analysis and reporting
data requirements. The SDSFIE was called the Tri-Service Spatia Data Standards (TSSDS)
prior to July 1999). The FMSFIE was called the Tri-Service Facility Management Standards
(TSFMS) prior to July 1999). The acronyms SDS and FM S were used from July 1999 until
January 2001. The SDSFIE/FMSFIE Release 2.00 was completed in January 2001.

Authors of the technical paper included Mr Eric Sheehan, Michael Baker, Jr., Inc. and Mr Barry
Schimpf, Upper 90, Inc. Technica review was accomplished by Ms Denise Martin, CADD/GIS
Technology Center.
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Background

About Relational Databases

Database Management Systems (DBMS) are used to organize tabular information for retrieval and
manipulation by multiple users and application programs. Data is normally organized into tables and
atributes.  Relational Database Management Systems (RDBMS) allow for the creation of links or
relationships between tables. The RDBM Sis the baseline for the SDSFIE/FM SFIE

Structured Query Language (SQL ) is the American National Standards Institute (ANSI) standard relational
database communication language. The SDSFIE/FMSFIE SQL Generator provided with the CD release of
version 2.0 of the SDSFIE/FM SFIE produces SQL statements that can be used to generateempty tables for
various types of RDBMS listed below.

Standard ANSI
Microsoft SQL Server
Informix

Oracle

Version 2.0 of the SDSFIE/FMSFIE introduced a separate tool for creating and maintaining Microsoft
Access databases. This SDSFIE/FMSFIE Access Builder not only performs many of the functions of the
SQL Generator specifically for Microsoft Access, but also permits analysis and modification of the Access
Schema, including definitions, domains and values, and expanded relationships. The new tool is aso useful
in upgrading from one SDSFIE/FM SFI E Release to the next.

About Access

Microsoft Access is an interactive database management system designed for the Microsoft Windows
operating system. Access has the ability to integrate data from spreadsheets, text files, and other database
formats. The user can directly import, export, and create relationships to: Microsoft Excel version 3.0 or
later, Microsoft Fox Pro version 2.x or later, Microsoft SQL Server, Borland dBASE |11 Plus, Borland dBASE
IV, Borland dBASE version 5.0, Borland Paradox version 3.0 to 5.0, Microsoft Visual FoxPro version 3.0,
Lotus 1-2-3, ASCII text and al ODBC-compliant databases. Access provides the ability to convert data or
reports into HTML so the user can create interactive databases and share them across an Intranet or the
World Wide Web.

Microsoft Access takes advantage of the graphical user interface power and ease of use in Windows,
giving the user visual accessto dataand simple, direct waysto view and work with information.

Access provides query and connectivity capabilities that allow the user to find desired information
regardless of format or location. With the use of SQL queries, the user can work with data stored in different
database formats and network locations. The user can easily edit SQL statements at any time and view



different layouts of data. Design toolsincluded with Access allow the user to produce forms and reports to
meet exact specifications. One can plot data, combine different forms and reports in one document, and
present reports with publication-quality style.

Microsoft Access provides integration with Microsoft Visual Basic. Integrated Development Environment
(IDE) features drag-and-drop code, color-coded syntax, a debug window, and in-place object browsing.
Visual Basic for Applications — the programming language shared across all Microsoft Office applications—
provides programming, interface, and debugging tools.

Obtaining Standard Symbology

Resources for creating standardized map symbols, fonts, line styles, and color shade setsfor ESRI GIS
packages are available from the CADD/GI S Technology Center’s home page at http://tsc.wes.army.mil. The
ArcView fileto download is ArcViewSym.zip, The map symbology resource files are not required to make
the spatial datafiles compliant with the SDSFIE/FM SFIE, but are recommended. The method for
implementing the color setswill be covered in the step-by-step tutorial presented in this document.




SDSFIE Implementation

Implementation Preparation

The first step in the implementation process is to perform an inventory of spatial data files you wish to
implement within SDSFIE/FM SFIE compliance. If thisisto be anew dataset, create alist of the Features (the
Graphic Map Elements) b be included in the database or dataset. A simple listing in a text file or
spreadsheet serves well asamethod to organize the datainventory.

Next you will select the features in the SDSFIE/FM SFIE that correspond to featuresin your existing data set
or feature list. The SDSFIE/FM SFIE Browser tool will help you with the feature selection process. Thistool
allows the user to browse compliant features by structure, feature name, key word, alias, or datasource. The
following steps demonstrate how to use the SDSFIE/FM SFIE Release 2.00 Browser application to find afew
different features that would be included in a utilities spatial data set.

SDSFIE/FMSFIE Toolbox

The SDSFIE/FM SFIE CD includes both the data and software that make up the SDSFIE/FMSFIE. The
software includes applications for finding, viewing, and printing information about the SDSFIE
features/tables and the FM SFI E tables (Browser). In addition, the CD includes software permitting usersto
custom tailor their own set of features (Filter Maker and Filter Eraser), facilitating the construction of a
database schemain an SQL Database (SQL Generator), building and maintaining Microsoft Access
databases (Access Builder), and simple data entry tools (Data Creator).

Thetoolbox software is specifically designed around the organization and structure of the SDSFIE/FM SFIE
dataand is provided free of charge by the CADD/GI S Technology Center in Vicksburg, MS. Questions
and/or problems regarding the toolbox should be addressed to the Center.



SDSFIE/FMSFIE Browser (Finding Features)

To open and configure the browser

1 From the Windows Start Menu choose
SDS FM S Browser Eorfgan Arcem Finl Fimz bndeas Hip
Figurel - TheBrowser Master Menu

B SDSFE SFEHEAE BanweeSiewe P

2. From the <Configure> menu choose
<Connect>.

3. In the Connection Screen (Figure 2), Verify and/or change the location of the data connection files
and choose <Connect, Test and Save>.

SDS5/FMS [FIE] Data Conneclions

ALCCESS Library Location

| HAD ata Sets\Release. 200 Browse ... |

Sumbology Image Files Location

| d:4Data Setshimages. 200 _B&SE;I

IDEF Model Files Location

| :\Data Setsthodels. 200 Browse |
Connect, Test, and Save I Help [F1] I Cancel and Cloze I

Figure 2 - The Connection Screen

NOTE: These connections are automatically repeated each time the Browser is started.

4, From the <Configur e> menu choose <Options>.

SDSFIE/FMSFIE Browser Options

IS Software 1 Special Featues ]

- Select the Desirted GIS Software Application

" MicroStation/G eographics ™ Arcinfo/brcyiew
" Intemgraph MGE " Geamsdia/Pro
" Other Software
Help oK | Cancel | Aok
Figure 3 - Setting Options

5. From the GI S Softwaretab (Figure 3) choose ArcView/Ar cl nfo, then choose <Apply> and/or
<Ok >.
6. Other configuration options, use the Special Features tab, and then choose <Ok >.



Browsing Techniques

Browse by Structure— Navigate through the SDSFIE/FM SFIE using its structure.

Next you will take alook at al the Entity Classesin the Utilities entity set.

1. Fromthe <Browse> menu choose <By Structure>.

2. Choose <Entity Sets> to display the Entity Set Window (Figure 4), then double-click on utilities from

the Entity Set window to display the Entity Class Window (Note: Double-clicking on any white background
field will jump to that element.

# Entity Sets
foy Facilies, fnfrestreciore, and Envionment
Embiy St Mane

Select an Enfity Set | ublibes
geology :l Diahration :
hydrogiaphy The man-made components of & sustem that -
Ifript criemerl provides & senvice ta the public. The
lard_status camponents of sach ullity system i this entity 2
g are located outside the foundation of 3 structure,
rilitany_operahons Communication systems are not ncluded and |
i actcay
ol ) Ertity Set Code I ut
transporkabon Mo Change in Release 2,000

Close | Help(F1)|  Print Eniy SetList |

Figure 4 - Entity Set Window

3. In the Entity Class Window (Figure 5), double-click on utilities_electrical_ext_light to view the
full definition and the associated Entity Types (Features)

o Fircalitves, fofrestrociore, o' Emvaromment
Entity Claze Name
|

: : ulibies_electrical e Sght
Silecd the desied Enlily Class Entity Set Name

I:J Uit =] [ uhibes

urlities_cnbil_mnle_system T E———
witlities_cnbsl_nl_system_B The components of an elecincal extenior ighling =

s cotiikiol G system inchuing cables, swiches, deviees, .

tranzhomers. el
uilities_edechical_spshem ;i
utlitie:_edechical_systern_fm
wrlities_lued_spstem View IDEF Madel i
uilities_thued_spstem_im Class Code I_
wilities_genesal -
wiiities_ general_fm Design File Prefis  [Totewl  Standad [ 505
utlitiez_heat_cool_system
utlities_heal_cool_system_im __J Mo Change in Release 2 000
AIEL A B Cose | HelplF1) |  Pint SelsctedClass |
 Faciity Manapement-
FMSFIE Classes Only I | ALL Inciuded Ertity Clasees SDSFIE Classes Dnk I

Figure5 - Entity Class Window



4. Inthe Entity Type Window (Figure 6), find the desired Entity Type in the Entity Type List.

28 Enlity Types

M= E3
SDS / FMS

for Farilities, fnfrastreciore, 2nd Eavionment
Entity Type Hame

exdaricr_kghting_pedn

Select the desired Ertly Type Enfiity Class hame [ whlbies _abecirical_gcd_light

| & Jtbies I :
[=Jutibes_seccal_en_ignt =] Diltotiori ] Eharlaae | Sy~ Ll

[ evteice g pont W ulikties

Ak Ertily Toper o Evnlom Filter

Objact Type Foint Stendlard [ s0s

Mo Changs in Releass 2 000

Detinkion
ILecations of poinl sources of geneni et el j
igirting.

Hep(F1) | Pl Seiected Type |

Figure 6 - Entity Type Window

The Window displays information about the Entity Type.

Browse By Feature Name — Find the Feature using its Name. Note that each Feature has only a single

name.

Next you will find the entity definition for an exterior
light

1 From the <Browse> menu choose <By
Feature>.
2. On the Feature List (Figure 7) find the Light,

Exterior by either scrolling down the list of
Features or filtering the list using the “L”
button for Light, and then finding “ Exterior”.

3. Double Click on Light, Exterior to display the
Feature Screen (Figure 8), which contains
detail s about the Feature including
organization, Table Name, Definition, and
Symbology Codes.

AlB|c|D|E|F|G|H[1]J]K|L|M
NlO|P|a|R|S|T|u|v|w]xX|¥]|Z
Display All Features

Light, Airfield Digtance b ark, -
Light, Airfield Fuel Pit Marker
Light, &irfield Helipad Perimeter
Light, Airfield Other

Light, &irfield Papi

Light, Airfield Prethrezhold
Light, Airfield Rotating

Light, Airfield Furiway

Light, &irfield Stobe Beacon
Light, &irfield T asivay

Light, Airfield Threshold

Light, E=terior Flood

iLight. E =terior Pole Mounted

. Externior Security

. Ewterior Street

. Exterior W alk

. Marine Mawigation

. Matural Gas

. Traffic

Line of Sight, Communications
Lire, Section

About Browesing by Feature
Figure7 - Browser by Feature



SDS / FMS

For Faciities, Infresfructore, arnd Enviromnment
Featue MName

| Light, Exterior Pole M ounted
Abas [T EXTERIORLIGHT  Modifier | POLE MOUNTED
[ Definition 1 Files/Tables 1 Symbology
Entity Get Name | whities Standards [TSDS
Entity Class Name | utiliies_electical_ext_hght Graphic Element Object Type
Entity Type Name | extenol_bghting_pomt Fowt
Mo Change in Release 2 000 i~ Entity Type Attnbute Discriminator =
Locations of point sources of general extemal  ~ | Discriminatar lit_twp_d
bohting. [ dedt
' ofValue [~ POLE_MOUNT
Add to Custom Filter | Close | Heb | [

Figure8 - Feature Screen

Browse By Feature Alias— Find the Feature using an Alias. Note that each Feature may have many aliases.



a8 Select the Feature Modifier E3

Modifier for Feature Alas -
Multiples on LIGHT

1

2.

From the <Br owse> menu choose <By Alias>.

On the Alias List (Figure 9) find the “LIGHT”.
Since “LIGHT” is an alias for more than one
Feature, a list of potential features will be
displayed. SeeFigure 10).

MATURAL GAS

FPOLE MOUNTED

EES&ET l'gm.'r” 3. Double clicking on the desired feature will jump to the
LIGH _

WwiLK LIGHT same Feature Screen (Figure 8).

SECURITY LIGHT

Figure 10 - Featuresfrom Alias

A|B|CIDIE|F|G|H|I

J
NIOJP|QIR|S|T|U|V|W

-\

Display All Aliases

LEVEE JOB
LEVEE PUMP STATION
LEVEE SLIDE

LEVEE STATIOM
LEVEE WORE SITE

LF RADIO

LIFT

LIGHT HELIPAD
LIGHT RUMWAAY
LIGHTMNIMG DISPERSAL
LIME

LIME OF SIGHT

LIVE FIRE RAMNGE
LOC/DME MAWVAID
LOCALIZER MalAID
LOCATOR MAWAID

LOCK

LOCK ARRIVAL POINT
LOCK CHAMBER

LOCK GUIDEWALL

LOCK OFERATION HOUSE

About Brawsing by Aliaz

L

-

Figure9 - Browser by Feature

Enter “light” into the “ Search For” field of the Keyword Search Window (Figure 11). Then click

Browse by Keyword
1 From the <Br owse> menu choose <By K eywor d>.
2.
Begin Search’.
3.

Double-click on the Entity Type Name — EXTERIOR LIGHT POINT in the keyword search results
list to display the Entity Type Screen for the Feature.




Keyword Search

EEEERRE iI

Sedect Al
Select Nore

Begin Search
About Browsing by Kepword

Figure1l - Keyword and Results

Eeyword Search Results For - light

Endity Class MName --- uilifies_electrical_ext_light
Enfity Clazs Dafinition --- uliities_alectrical _sxt_light
Ertity Type Mame --- airfield_light_poirt

Enttity Type Mame —- exterior lighting

Erdity Type Mame -—- marine_navigation_bght_poin
Erttity Type Mame - miditary_fliokt_corridor_area

Erity Type Mame —- maitary okt _cirection_arrow
Erity Type Mame --- miitary_flight_track_line

Erflity Type Marme --- natural_gas_light_point

Ertity Tvpe Detinition -— air_accident_zone_sres

Endity Type Definition -- airfield_light_point

Erity Typea Definition --- communications_fioeroptic_line
Ertity Type Detinttion - communications_groundplane_poly gon_ares
Endity Type Definition - exteror_bghting_point

Erdity Type Definition --- marine_navigation_light _point
Eraity Type Detinftion -— miltary_fhght_direction_arrow
Endity Type Definition - milkary_fhght_track_ine

Enfity Type Definition --- natural_gaz_light_point

Ertity Type Definitian - pedestrian_featurs_poirt
Entity Type Detintion --—- road_festure_poind

Feature Mame --- AIRFELD LIGHT + THRESHOLD
Feature Name - TAXMAY LIGHT

Feature MName -— AIRFIELD LIGHT + STROBE

Biowse Selection ] Print Riesults List Close

Continue using the Browser to gather pertinent information for your project spreadsheet or Feature List.

Moving from Feature to Table/Attribute — Each Feature/Entity Type in the SDSFIE/FMSFIE is linked to a
data table, which contains the specific attributes which define the characteristics and properties of the
Feature. To get from a Feature or Entity Type to the table, use the “FILE/TABLE” tab on the screen. To
jump to the applicable table, double click on the Table Name (ususally of the format SSCCCTTT where SS
corresponds to the Entity Set, CCC corresponds to the Entity Class, and TTT defines the specific table

This action will display [_ [T =]
the Table Screen M
(Figure 12). fer Facalities, ?ﬁwﬁaﬁﬁm an%fmr
The Table Screen Attrbute Table Name | trnarchn
displays information Galect the tesisd Tabla [ Transportation Marine
about the table, where I "= Jranspottation :] | r—
it is used, and any
relationships between | 2]tanspartation_marine =
tables. In order to see hmaracy = Definition T Enity Tvpes I Tork .
the attributes in a | [tmasai
particular table, double L’:“ﬂ:g;c Standard [ 5DS Table Type [ graphic
click on the table again  |hmarcau This tablle cortains information about channel areas. « |
in the list on the left i __J
side of .the. Table i ogkd s SR RE0E
Screen.  This will jump ep— Changs |
to the Attribute Screen,  |tmaplt = Real Property Reportng L
shown at the top of the Add Table to Fiter | Cose |[CTHERFIT ]  PintSelected Table
next pagein Figure 13. ~ Facility Management
FMSFIE Tables Orly | [ALL Included Attribute T ables SDSFIE Tables Ony |

Figure12

- Tables Screen



| 3% Data Attibutes [_[=[=] Figure 13 shows the
Attribute Screen, which

Transportalion Werke provides detailed

Channed information about the

Uriigpue Dats larifier attributes in a particular

i Salset the Table and Atribute Altribule Table Name [ tmecshas :ableétlnfludlng var(;;us
i T TAREnie Clasas = ormats for names, data
. |=lanEny = Aftribute Name | dstalink types, domain values,

' [omarche =

Definition | Dlaman 1 D54 Referencs definitions, and other

DetaTyps [ 1 Character Length [ pertinent characteristigs
of the aftribute as it

Table Postion  [7 Standerd [TS05 [ Mukdlowed | olates to the

[T Displayable tibete [+ Regured [~ Discimingtor SDSFIE/FMSFIE.
Revized in Releass 2.000

E::Hw. This atfribute normaky contans & linking key to ﬂ These names, data types,

esternal graphic element. 0 some systems, this key i3 and characteristics are

ed and papulated by the GIS. Care should be taken in ;! considered when using

| the SDSFIE/FMSFIE

toolbox to build and
maintain a database.

Heip (F1) | Prrk Selected Atirbute |

Figure 13 - Attribute Screen



Using the Filter Maker

The Filter Maker permits the devel opment, definition, modification, implementation, and saving of aFilter, or
subset of the entire SDSFIE Library. A filter is used to limit the size of the data schema used in a
SDSFIE/FMSFIE data implementation. Filters limit display and use of all aspects of the SDSFIE to include
Entity Sets, Classes, and Types, as well as Tables, Attributes, and Domains. A custom filter is a user-
defined filter. Although the creation of a custom filter isoptional, it will greatly increase the efficiency of the
SDSFIE/FM SFI E database generation process and is useful for nearly all of the toolsin the SDSFIE/FMSFIE
toolbox.

For the purpose of this guide, afilter named “LIGHTS” will be developed. The stepsoutlined in the
following section guide the user through the tasks necessary to create the filter.

Note: SDSFIE/FM SFIE data does not support filter operations with pre-TSSDS/TSFM S 1.80 releases.

Toopen theFilter Maker and create afilter = SDSFIE/FMSFIE Custom Filter Maker
1. Fromthe Windows Start Menu choose Filter The initial step in the creabon of one o mare 5D SFIE/FMSFIE
M aker Fikters iz o ncate and connect to the desired A eleaze of the

SDSFIE/FMSFIE. It i wise bo backup the SDSFIEAFMSFIE Libiary
prioe bo this action since this program will modfy the comtents of
these Libranes. These files can be found in & diectory caled
. . Fielease wnx [wi = Release Mumber of the SDSFIE /FMSFIE]
2. Onthefirst panel of the Wizard, choose - : ;
Thiz will be the same dischony whese you correct with he

<Connect> to connect to the SDSFIE/FMSFIE SDSFIE/FMSFIE Browsel of olthe Toolbox Comgonents:

Library.
y If pou do not pozsess a valid SOSFIE Releass, it iz avalable from
the SDSFIE FMSFIE Wab Site at tzc.wes. amy.mil

Connect bo SDSFIE £ FMSFIE Librane 1

Eit | Heip |

Figure 14 - Filter Maker

3. Onthe Connection Screen (Figure 13) Verify and/or change the location of the data connection files and
choose <Connect, Test and Save>. Click <Next>.

SDEFIEFMSFIE Library Location

| C:\Program Filer\esddhFelease. 200 Browse .|
Cornect, Test, and Save | Help i Cancel and Close |

Figure 15 - The Connection Screen

4. Choosethe“Create aNew Filter” option, and then choose <Next>.



5. For the name of your filter enter “ Exterior Light”, and then choose <Next>.

w SDSFIESFMSFIE Custom Filter M aker

The nest step in the development of & Fiker i bo provide & name
wihich will iefer lo the Fiter. This name will appear in the Fiker Meru
in the SOSFIEFMSFIE Browser and the Files Selection List Box in
the SDSFIE/FMSFIE Generator and Bulder tools.

|Etenor Light

If & Custom Fiter has sready been developed and has been
loaded inta the designated SDSFIE/FMSFIE Libraiies, the
nafe of he Fiker wil be displased in the Ted Box above,

Flestore 4 Previous Fiter |

- Provious Next --> Exit | Help ]
T I
Figure 16 - Naming a Filter

Continue through the Wizard until the Feature List is reached (See Figure 15).

» SDSFIE/FMSFIE Custom Filter Maker

The next step iz to identiy the Features to be included:
| aurmgt_abatement_festee

| aurngt_notze_abatement

| auroi_noise_contou
| aunoi_moise:_incidert_sile
| | aunoi_noize_sample

| aunoi_roize_sowce

| aunoi_nose_zone

| bdeco_enchusive_economic_zone
| bdjur_appros_boundary
| bdyur_border_courdry

| bdjur_border_county_pasish

] bfjur_Barder_municipality =]
| Select Featwes Dialon | Unselect Al Featurss |
Mest --» I Exit I Help |
Felease 200 | Exterar Light

Figurel7 - List of Potential Features

Choose <Select Features Dialog>. This button displays a Dialog which permits users to select Features
based on the Structure of the SDSFIE/FMSFIE; e.g. by Entity Set, or Entity Class, or Entity Type, or
based on a previous constructed filter or one of the “canned” filters in the SDSFIE/FMSFIE. (See

Figure 16)

10



w, Selecting SDSFIE/FMSFIE Elements to Add

- Select Tablez basedon--- ———————
i Al SDSIFIE) Features

| i Feahures in selected Enfity Set

i~ Features it selected Entity Class

i~ Features in selected Filter

* Single Feature Selection

Access Channel 3
Acces: Location, Contiolled Militarny
Access Location, Uncontrolied
Accident Zone Air
Accident, Marine
Acid Concenfrabon Area
I Arid Concentraton Conbovr
Acquisibion Boundany Area __:j

Add Feature [

.Figure 18 - Selecting Features

8. Choose “Features in selected Entity Class’, select “utilities electrical_ext_light”, click <Add Class>,
and click <Insert in Filter>.

9. From the Wizard, click <Next>.

10. At the Summary Screen (Figure 17), verify the Features, the Filter Name, and edit the Filter Definition as
desired, click <Next>.

wr. SOSEE/MSFIE Custom Filter Maker _ ] <]

The final ztep iz to zave the Dizcipline and begin the
update of the SD5/FMS Libraries

Build a Filter named Exterior Light

The Filter Containg 5 Features

Save the Filker to

C:%Program Filezh T SS05YFilkershExterior Light. sdf

Filker Dezcrption [Edit az dezired)

A Locally developed filker aszigned an Friday, September _—J
14, 2001

-

E xit | Helpl

<-- Previous |

| Releaze. 200 I Exteniar Light
Figure 19 - Summary Screen

1
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When correct, click <Create>.

When the Filter has been entered into the SDSFIE/FM SFIE Library, the Filter Maker will display

. Filter Creation Completed <]

Filtler Completed
Completed Fiter -- Extenar Light

d\Data S etz\FHeleaze 2004 ssdzlib, mda

&

Figure 20 - Completion Screen

After 30 Seconds, the Dialog will automatically close and the Filter Maker will terminate.

Erasing a Filter

The Filter Eraser is used to restore the SDSFIE/FM SFIE Library to its original configuration. It operates very
similar to the Filter Maker (Wizard). The following steps are to be used in erasing a user created custom
filter (*Note: the SDSFIE/FM SFIE Filter Eraser is a separate program like the Filter Maker)

1. From the Windows Start Menu choose Filter Eraser.

2. Choose " Connect to SDSFIE/FMSFIE Library’.

3. Establish the connection in the same manner asthe Filter Maker. Click <Next>.

4. Choose thefilter(s) you would like to erase, and then choose <Next>.

ﬁ:-; SDSFIE/FMSFIE Custom Filter Erazer

Installed Filters
™| Erity

[+ Exterior Light
= Ermipty

= Emipty

™| Eristy

= Ermipty

= Ermpty

™| Eripty

= Ermpty

= Ermpty

{-- Previuusl

[ Felease 200 [
Figure 21 - Filter Eraser Filter List

E xit | Helpl




5. Atthe Verification Screen, choose <Erase>.

Using the Access Builder

New to release 2.00 of the SDSFIE/FM SFIE isthe Access Builder. Thistool automatically builds the SDSFIE
structures (tables, attributes, and domains) in a Microsoft Access database. It replaces and expands the
functionality of the SDSFIE/FM SFIE Generator Tool first introduced in Release 1.600 of the TSSDS. Version
2.0 of the Access Builder generates a Microsoft Access 97 database. (Future releases of the Access Builder
will support both Access 97 and Access 2000). This tutorial will use the builder to create a database
structure used to store field-captured data pertaining to the exterior lighting system.

To open and build a database

1. Fromthe Windows Start Menu choose Access Builder.
2. From the <Open> menu, choose <Library Connection> to connect to the SDSFIE/FM SFIE Library.

3. On the Connection Screen. Verify and/or change the location of the data connection files and choose
<Connect, Test and Save>. Click <Next>.
4. From the <Open> menu choose <Cr eate Access Database>.

5. For the database name enter “Exterior Light”, and then choose <OK>.

6. Choose “Tables in Selected Filter” and double-click “Exterior Light” to add all the features to the
Candidates List.

7. Choose <Add to Candidate List>.

im. Selecting SDSFIE/FMSFIE Elements to Add '

- Select Tables basedon--- ———
= Al SDSFIE/FMSFIE Tables
{~ Tahbles in selected Entity Set
= Tables in selected Entity Clazs
{*' Tables in zelected Filter
{~ Single Table Selection

Exterior Light

Civil \wharks
Ernv Compliance
Er Hestoration

{E=tenor Light

Range And Training
REEGIS

Small Scale Mapping

Add Filter | Delets Filter |
Add to Candidate List | Close |
Figure 22 - Selecting the Filter

8. From the <Action> menu choose <Add Candidates to Access> to display the Addition Option Dialog
(Figure 21).
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ey Adding Candidates to an Access Database

Bdding Attribute Data

¥ Add Long or Common Narmes bo &0 T ables
v Add Long or Common Mames to &1 Atnbutes
i | inciude Aitribute Definitions n T able Design

[# Create INDEX for Primary Key [Field will be NO NULLS)
Adding Related T ables and Relationships

[ Create the Database Jons Table
¥ Create the Relationships where Possible

Adding List ard Fange Dornan Constraints
v Buid Required D omain Tables and creste LOOKUP Aeferencas
+ In the Current Access Database as Normal Tables
™ In the Curent Access Database as "Hidden" Tables
" In a Bemote Access Databaze [Domain, mdb)

Buld/Generste | Help | [Close/Cancel |

Figure 23 - Addition Options

Note: Seethe Application Help File for information on the available addition options.

9. Choose <Build/Generate> to convert the candidates to Access Tables.

Populating the SDSFIE/FMSFIE database

The next step in the implementation process is populating the database. Y ou will notice that when “Exterior
Lights.mdb” was created, it was an empty database. To use the database you must populate it with the
appropriate data. Many techniques may be employed to populate the Access database, including “Import”,
Forms, manual input, or another application. The Access Interface offers a number of options for adding,
modifying, and editing data. (If you are using Microsoft Access 2.0, you must convert the “Exterior
Lights.mdb” file (whichisaMicrosoft Access 97 file) before populating it with data.)

Inthistutorial, we will populate the database by importing records from atext file that describes the features
in the spatial data set. The Access Builder created all necessary tables and relationships among them. An
ASCII text file (lights.txt) has been provided as a supporting document of thisreport. Note that the first
record in the text file is aheader that contains the appropriate SDSFIE/FM SFIE attribute names which
coincide with the fields of descriptive information in the text file. Itisnot necessary to include all the
attributes from an SDSFIE/FM SFIE attribute table in the text file to be imported. The following steps will
popul ate the SDSFIE/FM SFIE — A ccess database.

1. Start Microsoft Access. Open the database Exterior Light.mdb by selecting Open Database, from the
File menu. If the <Convert/Open Database> window is displayed, choose <convert> and type in a new
file name for the conversion. Make the Tables Objects group active.
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gia tutor - Database

b open Bf Design -\ hiew | b

=] 3

kel

COhbijects Mame | Description ﬂ
ukelesit Suitch
ukelethk, TransfFarmer Bank
ukeletvt TransFarmer Yaulk
ukeleuti Llkility Electrical Utility Site
ukelicir FIM - Utilities Electrical Diskribution Sy
ukelient Electrical System Ductbank,
ukelisec Electrical Section
utelitfr Transformer J
T

Groups

-

Lltilities Electrical External Lighting_lll
| 3

2. Select Get External Data/l mport from File menu.

a.  Withinthe Import dialog, select Filesof Type: Text Files (*.txt;*.csv;* .tab;*.asc)

b. Browsetothefilelights.txt,
c. Click Import

Look in: (] tsc

File name: lights. txk

Files of Eype: [Text Files [*,kuty*, covi . taby* asc)

7|

ﬁ' Import

Cance

mpot —————————___[@H|
j = |@xﬁ* Tonls »

3. Fromthe Import Text Wizard window, select these optionsto import the data.
a.  Select Delimited—Characters such ascomma or tab separate each field

Click Next
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b. Select Comma asthe delimiter that separates your fields. Check First Row Contains Field Names,
Text Qualifier {none} Click Next.
B Import Text Wizard I

what delimiter separates vour fields? Select the appropriate delimiter and see howe vour bext
is affected in the preview below,

—Chonse the delimiter that separakes vour fields: ‘

" Tab " Semicalon * Comma " Space " Other: i
v First Row Contains Field Mammes Text Qualifier: i{nu:une} - I
datalink [ext 1lit id |[coord X coord ¥ coord =
1 WMEO01 F1355258.9410 1022034.6267 |50.1 Eﬂ
[2 MPO12 [F135530.4800 [10Z22154.1329 47.7 =
] WMPO13 F135354.6038 1022221.7490 [@9.7 =
£ MrO14 F135225.7135 [1022281.1696 d49.9 =
15 WMEO15 F135431.2202 10Z22105.8280 MB5.3 il
& MPO16 F135465.1415 [1022041.6312 Mda.4d C:j
2l i3
Advanced... ! Cancel = Back I Mext = I Einish i

c. Select the button to specify that the data are stored I n an Existing Table, choose utexllit.

d. If thetext file you areimporting contains attributes that are not included in the SDSFIE/FM SFIE
table utexllit, click the <Advanced> button. Click inthe‘Skip’ box for each attribute that should
not be imported to table utexllit. Click ‘OK’.

e. Click Finish. Click OK to the dialog confirming the data were imported successfully.\

4. Doubleclick theicon for the table utexllit, from the Table objects group to open and view the data.

B utexllit - Table M= E3

datalink ext lit id
251 WPon1
252 WP012
253 WP013
254 WPO14
255 WPO15
256 WPD16
257 WPO17 -

Ecord: Hl 1 II 14k IH|P*| of 16 €1

5. No other actions within Microsoft Access are required to link to ArcView GIS 3.x. To closethe
Microsoft Access application, select Exit from the File menu.
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Note: The Release 2.000 Access Builder constructs Access databases that are compatible with Access 97.
If Access 2000 isrequired, it is necessary to use Access 2000 to perform the transformation.

The SDSFIE/FM SFIE ToolBox also contains a Data Creator application for Microsoft Access.

Using the Access Data Creator

Toopen thedatabase and select atable

1. Fromthe Windows Start Menu choose Access Data Creator.
2. From the <Database> menu choose <Open>, and then select the Access database.
3. AListof available tableswill be displayed (See Figure 22).
4. Select atable and the Fields associated with that table will be displayed.
Toadd arecord i, Table Selection l
1. From the <Recor d> menu choose <New>. bggenstr -
cdplzant
. . cdplzzea
2. Enter data as appropriate. Choose <Save Recor d> when finished. carelpar
CMgencon
3. Repeat the process for all the data as required. cmgenmet
coctioc]
. cowltilos
4. From the <Database> menu choose <Exit> to close the program. achabars
fagencls
fahabspc
farngtoon:
gdsgzqud
gezurazo
hwhdbdrg
Fkidbats
Fysurbirk l‘

TK—_]  Cancel

Figure 24 - Table Selection
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Creating an ODBC Data Source

Open Database Connectivity (ODBC) provides a standard interface between an application (i.e., ArcView)
and the database (i.e., MS Access). In order to create an ODBC data source for MS Access, perform the

following steps:
1. From'‘Start’ menu, select ‘ Settings', ‘ Control Panel’.
2. Double-click the*ODBC’ icon.

3. If*MSAccess Database’ isnot listed under the ‘User DSN’ tab, then
a. clickthe‘Add button,

select “Microsoft Access Driver (*.mdb)”,

click the ‘Finish’ button,

type ‘M S Access Database’ asthe Data Source Name

click ‘OK’

Poo o

4. Pressthe‘OK'’ button.

E10DBC Data Source Administrator I

User DS | Systern DSM | File DSM | Drivers | Tracing | Connection Pacling | Abaut |

Uszer Data Sources:

I ame ! Diriver | Add.
dBASE Files Microzaft dB aze Driver [*.dbf]

dBaze Files - wWord Microzoft dB aze VFP Driver [*.dbf) Bermaowve |
Excel Files Microzaft Excel Driver [*.#lz]

FosPro Files - Word Microzoft Fo=Pro WEP Drver [*.dbf] Configure. .. |
GADMOD2 Microzaft Access Driver [F.mdb)

M5 atabase Microzoft Access Driver [.mdb)

SDSFIEAFMSFIE Ciriver do Microzoft Accesz [*.mdb)

Wizual FosPro Databaze  Microsoft Visual FosPro Driver

Wizual FoxPro Tables Microzoft Wisual FoePro Driver

A ODBC User data source stores information about how to connect to
the indicated data provider. A User data zource iz only visible to wou,
and can only be uzed on the current machine.

K I Cancel | Eppl Help

Figure 25 - Configuring an ODBC Database
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To configurethe SQL Generator

1. From the Windows Start Menu choose SQL Generator.

2. From the <Configure> menu choose <Connect>. See Figure

26.

3. Verify and/or change the location of the data connection files

and choose <Connect, Test and Save>.

4. From the <Configure> menu, choose <Options> See Figure 26.

5.  Onthe <Output> tab, type the following:

Generste  Help

Configure
Connect
Ophions
Configuration

Fririt Setup

Exit
Figure 26 - Generator Menu

ASCII Output FilePath: C\..\TSSDS\Generate
ASCII Output FileName: LightsTable.SQL

Click <Save Options>.

6. From the <Configure> menu choose <Configuration>.

7. Under GIS Application Configuration choose ArcView/Arcinfo.

8. Under Database Configuration choose Oracle SQL.

Generation Condiguration

Generation Configuiation

_________________ |

i 15 Apphcahon Configinshon |

BI5 Application Configuiation | [atabase Configuration
Setect Cunent GIS Application:
™ Iréergtaph MGE " ESRI dicinia

[~ Select an SOL Carvwerition ot ACCESS Diect

T AMSIS0L [Use with RIS " Irfoemis SEL

 MicroStalion/Geographics & Oracle SOL € Mool SOL Sesver SOL
™ AurolAD Map .
Help St Configuiation Camal Help Set Configueation Cancal

Figure27 - Select ArcView
9. Click <Ok>

To generatetablesand attributes

Figure 28 - Database Selection

1. From the Generate menu choose New, then Table and Attributes.

2. For the Generation Mode choose Custom
Filter Schema, then double-click “Exterior
Lights’ custom filter.

o DSFIE/FMSFIE 501 Generalor

[ables ard Attnbuile:
Domaing and Walues
Release Upgrades Relationships/Joine
Figure 29 - Generating Tablesand Attributes
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Generate for SDSFIEFFMSFIE Tables and Attributes

Select the Generation Mode
" Complete Schema & Custom Filter Schemafs}  Single Table
 Ertity Set Schema(s)  © Entity Class Schema(s)
Generate bo
™ Detault Punter - First 2 Pages
eh \Oracke\SELSYR.SAL
&+ Maamum 1000 Lewe S ample

Exterior Light

Cral Works
Erre Compliance
Erv Restorabon

{E wtegior Light
Range frnd Trainmg

REEGIS
Sl Scale Mapping
Cretaull Schema Hame I
AddElement | Delete Element | Heip | Genersin Class

Figure 30 - Selecting Features
3. For “Generate to”, choose C:\..\TSSDS\Generate\LightsTable.SQL to save your code to the file you
specified previously

4, Choose <Generate> then <Close>.

To generate domains and values [Rsiaglaia fiaal ST i 1 R AT AV e

(See Figure 31) Select the Generation Mode
Al Domains " Single Domain & Prior Generation
1. Fromthe <Generate> menu
choose.<New>, then ¥pe ist - address ia| —Generste o
<Domainsand Values>. niaeme list - country = Defaul Prnter - First 2 Pages
e ¢ DA MExiLights SAL
. oo A MEH
2. For the Generation Mode E::::a ) ;T,fe S i
choose <Prior Generation>. unit of measure ¢ MUK EKH s S M s
type §st - confract
3 For“Generate to” . doubl type st - contractor rating
. For “Generate to”, double corfract type -
click on corfract - compstition type G
. . cortract - competion
C\..\TSSDS\Generate\Lights pvack s
Table.SQL and change the corfract - action Dracle
filename to Cg_t'*'“: " 5Mﬂ“$ﬁm st
. . [ ract = compesd [ 1
“LightsDomain.SQL".
Diefacll Schema Hame [—‘ Locate Generation SOL ]
4. Choose <L ocate Generation Help Ersas I o |
SQL>, choose thefile

“LightsTable.SQL” from the Figure 31- Building Domain Values
previous step, then choose <OK>.

19



SDSFIE/FMSFIE Joins / Table Relationships

5. Choose <Generate>, then

Select the Genssstion Mode
<Close>.
© AllJaing  © Single Table Foreign Keys & Prior Generatian
i A cmgenadd i Generate to
Togeneratejointable cmgener € Defaul Prinles - Fist 2 Pages
relationships Emgercon
cmgencol O Do ALightsloins, SEL
emjercid . .
1. Fromthe <Generate> menu cmgencls " Masimuen 1000 Line Sample
cmgentac :
choose <New>, then emgerfoe
<| i i ins>. CMmgermsn
Relationships/Joins i A o Machrions
CMgarmLen
2. For the Generation Mode EmOEpCC i
. . CMgErE|
choose <Prior Generation>. CIMgerven Oracle
crmmedmed
cmmeabci 1]
3. For “Generateto”, double click ;
o Default SchemaMame [~ Locate Generation SOL I
C\..\TSSDS\Generate\LightsDoma Help ] Generate | Cloze |
in.SQL and change the filename to - - - .
) . Figure 32 - Building Relationships
“[_ightsJoin.SQL . g g P

4. Choose <L ocate Generation SQL>, choose thefile“LightsTable.SQL”, and then choose <OK>.

5. Choose <Generate>, then <Close>.

Compiling SQL Code in Oracle
Tocreateauser

Y our Oracle DBA should assign a username and password for you. For this guide we will use the username
USER with the password PASSWORD.

Using SQL + Worksheet

Your Oracle DBA should use SQL+ Worksheet to load and compile the 3 SQL files created from the SQL
Generator.

To populatethe database
Y our Oracle DBA should import the 2 text filesinto your newly created data structure.

NOTE: The SQL Scripts generated can be run directly into the Oracle SQL Plus series provided your DBA
has created the owner and database, and you have configured SQLNet and the ODBC Data Source.

The syntax for running these scriptsin SQL Plusis:

@ C:\Program Files\TSSDS\Generate\LightsT able.SQL

19



19



Configuring an Oracle Database in ArcView

You may configure an external Oracle database for use with ArcView 3.2 by using Oracle Provider driver.
This driver is loaded during the initial installation of ArcView. Unlike Access, the process for using Oracle
asyour data sourceis not as automatic. Y ou will have to manually create aDSN and UDL file.

Toset up an ODBC

1. Fromthe Windows Start Menu choose Settings, then Control Panel.

2. Double-click on Data Sources (ODBC).

3. Under the System DSN tab choose Add.

¢ 0DBC Data Source Administrator ilil
User DSK  System DSN | File DSM | Drivers | Tracing | Connection Pooling | About |

Systern Data Sources:

Ciriver |
i Microsoft Access Driver (. mdhb)

Bemowe

Configure...

1l

An ODBC Systern data source stores information about how to connect to the
inclicated data provider. A System data source is wvisible to all users on this
machine, including NT services.

Ok Cancel Apply Helg

4. Choose Microsoft ODBC for Oracle from the driver list, and then choose <Finish>.

5. Enter a Data Source Name and the Server Name (get this from your Oracle DBA). For thistutorial we will
use acadmap for the DSN and acadmap for the Server.



Microsoft ODBE for Oracle Setup ' 2] x|

Data Source MName: Iacadmap oK |
Description: I Cancel |
User Name: | Helg |
Sener: Iacadmap Optians >> |

6. Choose <OK> then <OK>

€ 0DBe Data Source Administrator 2] x|

UserDSN System DSN | File D3H | Drivers | Tracing | Connection Pooling | About |

Systemn Data Sources:

Mame | Driver |
Microsoft ODBC for Oracle
ECDCMusic Microsoft Access Driver (*.mdh) Bemove

Configure...

i

An ODBC System data source stores information about how to connectto the
indicated data provider, A Systermn data source is wisible to all users on this
machine, including MT services.

Ok Cancal Apply Help
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ArcView GIS Characteristics and
Capabilities

ArcView 3.2a

ArcView geographic information system (GIS) software from Environmental Systems Research Institute
(ESRYI) isacomplete system for accessing, displaying, querying, analyzing and publishing geographic data.

ArcView is capable of linking to Microsoft Access, dBASE, FoxBASE, ASCII, INFO or any SQL or ODBC
(Open DataBase Connectivity) database to graphic featuresin a geospatial set. ArcView supports virtually
an unlimited number of dynamic linkages to non-homogenous DBM S formats that may reside on alocal disk
or on a heterogeneous network at another location. Many layers can then be classified and symbols
assigned based on data attribute values. ArcView also provides extensive tabular data analysistoolsto
sort, query, and create statistical summaries, add new fields, calculate new information based on existing
attribute fields, or interactively edit the contents of any field.

ArcView supports vector and raster formatsincluding the Arcinfo and PC Arclnfo vector feature types (e.g.,
points, lines, and polygons) and Arclnfo’ s advanced feature types (e.g., routes and regions, raster images
and surface grids). Geographic data sets, such as satellite images and aerial photographs, can be geo-
referenced and displayed underneath vector themes for visual reference or as a background source for data
entry. ArcView supports ERDAS, BSQ, BIL, Sun raster files and run-length compressed raster files as well
as both opaque and transparent image display.

For information on the most current version of ArcView and its capabilities please visit ESRI’ swebsite at
http://www.esri.com/software/arcview/index.html




Implementing the SDSFIE/FMSFIE
Using ESRI ArcView GIS Version 3.2a

Software Requirements

Primary GIS Softwar e Package
ArcView Version 3.x

Primary Relational Database Softwar e Package
Microsoft Access 97/2000

Operating System
Microsoft Windows NT version 4.0, Windows 2000/98/95

Database Driversfor Operating System Drivers
Microsoft Open Database Connectivity (ODBC) Desktop Database Drivers version 3.51
installed. These are necessary to allow ArcView to read information directly from a
Microsoft Access database (*.mdb)

Sample Data Sets

The data used for the SDSFIE/FM SFIE Implementation Report was developed by the CADD/GIS
Technology Center for Facilities, Infrastructure and Environment in Vicksburg, MS. These datasets include
an ASCII text file, lights.txt, and three shape files: lightspro.shp, (exterior light features, graphics only -see
implementation scenario 3 below) bggen.shp (buildings general-buildings structure) and trveh.shp
(transportation vehicle road segments).

SDSFIE/FMSFIE Implementation Scenarios

Various applications of GIS require specific implementation strategies depending on the type data available,
graphic, tabular, hardcopy or GISready to use digital spatial data sets. Issues that require consideration
prior to integration with GIS are: (1) knowledge of the data origin and/or development cycle; (2) graphic data
may need to be digitized, and attributed manually to assign descriptive values; (3) graphic datathat are
digital without descriptive attributes; or (4) spatial organization or GIS ready data sets such as those
available from the World Wide Web. To implement any of the above scenarios, auser must have a clear
understanding of ArcView and the SDSFIE/FMSFIE.



ArcView Project Setup with the SDSFIE/FMSFIE

The applicable implementation task covered by thisguideisfor GIS ready data sets that are to be process
for SDSFIE/FM SFIE compliance. The graphic datafiles are provided as ArcView shapefiles (* shp), and
additional attribute information is provided as a standalone ASCI| text file.

The user should be advised that if it is necessary to edit a non-ESRI graphic datafilein ArcView, (for
example, making an update to the geometry or attributes), the data file must be converted to an ArcView
shapefile. When a CAD file (MicroStation or AutoCAD) is opened in an ArcView environment, all features
portrayed in the file are interpreted as lines, points, polygons, text, and/or annotation. All graphic attributes
associated with these featuresi.e. layer, level, color, linetype, line width, and style are presented in an
attribute table (either line, point, polygon, or annotation attribute) for the CADD file map dataset. Itis
advised that all editing of non-ESRI spatial datafile take placein the “native’ software environmenti.e.,
MicroStation or AutoCAD.

A similar situation exists with database file. ArcView can utilize and analyze values from an existing RDBM S
(Access, Oracle, SQL Server), however, the user cannot populate or edit the database tables directly using
ArcView'sgraphical user interface. If it becomes necessary to edit the database file it is recommended this
operation take placein the “native” environment, i.e., Oracle or Access.

Preparation of Attribute Data for Inclusion in an SDSFIE/FMSFIE Database

Thework flow diagram below outlines the steps that are used to establish an ArcView working environment
with the SDSH E/FM SFIE.

ArcView SO FMS
Project Setup Implementation
[titiate [ritiate SDE/FLIE
ArcWiew Jession Data et
’_l | |
_ - Build Relational
Create Views Cu:unnecT, to Database Database (Access,
Via 0L Ciracle, etc.)
| |
Extract Applicable join Choose Applicable Fopulate Applicable
Feature Tables Database Tables Tables

Relationship between ArcView Project setup and SDSFIE/FM SFIE implementation.
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ArcView Implementation

After the SDSFIE database is created and populated, and the ODBC drivers configured, a connection to the
database can be established within ArcView. Two ArcView shapefiles, trevh.shp, and bggen.shp,
representing base map feature geometries (points, lines, polygons), are included with this report.

gk owbdpE

Press Start/Programs/ESRI/ArcView 3.2/ArcView 3.2 from the Windows Desktop.

Inthe ArcView Project window, select the Viewsicon, click New to create anew View.

Save the project file tutorial .apr for later reference.

Make the View window active and select the Add Theme from the View menu.

Browse to the location of the base map shapefiles, trevh.shp, and bggen.shp. Hold down the shift
key and click once on each file name in the Add Theme dialog. Click OK to add both of the themes
to the View window. To display the features, click inside the box,placing a check beside the name
of each filein the View Table of Contents.

To make the Project window active, select tutorial .apr from the Window menu .

Select SQL Connect from the Project menu to display the SQL Connection dialog. From the
Connection drop down list, select MS Access Database. Click the Connect button, and browse to
select the Exterior Lights.mdb SDSFIE/FM SFIE database. Click OK.

Doubleclick utexllit from thelist of Tablesin the SQL Connect dialog. Double click <Al
Columns> from thelist of Columns. In the Output Tabletext entry box, type utexllit. Click the
Query button. Thetable will be added to the ArcView project. Close the SQL Connect dialog by
clicking on the close window X button the in the upper right hand corner of the window.

- FEESEED = T
Tables:
Lizhed =
Laebong datink:
Lisit ekl
napid
LR :J meta i
= redia i =
Domar |
Gebsel:
L T
s
OupaTade  [uck Oea | Tusy |
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9. Returnto the View window containing base features data sets. Select Add Event Theme... from
the View menu. Activate the X-Y button in the top left corner of the Add Event Theme dialog.
Select utexllit from the Table selection drop down list. Select coord_x from the X field drop down
list. Select coord_y fromthe Y field drop down list. Click OK.

Table: | utexllit =l

% figld: | Coord, & =l

* fcldl; HRE

(18 ; Cancel i

10. From the View, make Utexllit the active theme. Select Zoom to Selected from the View menu. This
will zoom the window to the spatial extent of the streetlights theme. Make the point features visible
by clicking the theme check box.

11. Select the I dentify tool from the ArcView tool bar. Click on any of the point features of the UtexIlit
theme. This action will bring up the I dentify Result dialog to confirm the point location and
associated attributes from the Exterior Lights.mdb database.

o] Utexlit
ﬂ Trieh.shp
AN

ﬂ Bagen.shp

Instin_id e
Facil_id
Lit_typ_d STREET_LIGHT
User_flag
= | .Coord_» 2148225, 710000
T Coord y 1022281160000 =
Clear Dearal | [« | 3
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Alternative Implementation Scenario

1

Return to the View window containing base features data sets. Add the theme lightpro.shp to the
current view. This data set included the graphic light features without all of the attributes from the
SDSFM S/SDSFIE database table.

Make the Project window active and highlight the Tablesicon. Double click on the utexllit table to
open it. Click on the field named Datalink to makeit active.

Return to the View window containing base features data sets. Click on the lightpro.shp theme to make
it active. Select Table from the Theme menu to open the Attributes of Lightpro.shp table. Click on the
MSLink field to make it active.

Select Join from the Table menu. The utexllit table will automatically close, and itsfields will be
appended to the Attributes of Lightpro.shp table. SDSFIE/FM SFIE attributes can now be viewed by
using the I dentify tool.

Naming Conventions

The next step in the SDSFIE/FM SFIE implementation for ArcView GIS 3.2ais using the proper naming
conventions for data sets for the View document and the ArcView project file (*.apr).

28

1. Activatethe View containing the base data and street light themes. Select Properties from the
View menu. In the Name entry box, type exterior_lighting_point. Select Feet from the Map Units
drop down list. Select Feet from the Distance Units drop down list.

2. Thefinal step isto savethe project file under a new name. Select Save Project As... fromtheFile
menu. Save the file asutilities_electrical_ext_light.apr under adirectory on your computer named
Utilities.

Fil= Hame Diregioaies
[ 1dilitime_mlachical_med_lighl ap whapropeber sorAsdsdanywdiiies

Er udilies

Dl
[ VLA NOLE =]

3. Theexerciseis complete, at thistime you can end your session by selecting Exit from the File
menu.



ArcView Symbology Implementation

Thefinal step in the processisto implement SDSFIE compliant and color schemes for featuresin the
dataset. To load the ArcView SDSFIE color set that isincluded with this report, follow the steps outlined

below.

1. Choose Symbol Window from the Window menu. Click the palette manager, far right button
on the window. Change the Type drop down option to Color. Click the Clear button to
discard existing colorsin the palette. These will be replaced by afull set of SDSFIE compliant

colors.

2. Click Load. Browseto the directory where the file sdsfie.avp is stored. Select the file and click

OK.

i Palette Manager =] [S[=]

Load...

Save..

Clear

tMake Default

Fleset

! Load Palette

File: Marne:

| sdsfie.avp

List Files of Type:

Cancel

Directaries: aK I
dihtsc

Dirives:

| Arcview Palette [%.avp)

] |

3.  Thefull set of SDSFIE compliant colors are now available to symbolize the datasets.
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